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Installation

Installing the programs from the CD

This CD contains a Master Installer program that provides an easy and convenient way to
install the programs on the CD.  Follow these instructions to use the Master Installer.

1) Insert the program CD into the CD-ROM drive.
2) From the Windows Program Manager,  click once in the File menu option to

display the File menu and select Run.
3) In the Run dialog box, type D:\INSTLL.EXE (note the spelling, no “A”), and

press Enter.  If your CD-ROM drive letter is not D, substitute accordingly.
4) The Master Installer main screen is displayed and you are presented with a list

of products to choose from.  Make your selections from the list and click on
Install to continue.  Master Installer will launch the individual installers  for
each of the products selected, and return to the Master Installer screen.  Follow
the on-screen instructions to complete the installation for each program.  Please
note that some installations may restart your Windows session.
If you encounter problems installing several programs at once, quit the Master
Installer program, and restart it.  Install one program at a time.

The On-Line User’s Guide

Documentation for these products have been provided in an on-line format, along with a
Viewer utility.  To view the manual, you must first install the Viewer program from the
CD.  To do this, follow the instructions in the above section.  The last option shown in the
Master Installer list box installs the Viewer program to your hard drive.  Please note that
this installation restarts your Windows session.

After the installation is complete, run the Viewer program and from the Open File Dialog
box, select the file called MANUAL.PDF which is located in the MANUALS directory of
the program CD (e.g. D:\MANUALS\MANUAL.PDF). The Viewer also contains a full
and comprehensive help system to assist you in learning how to use the documentation.
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SoftKey ClipArt
Getting Started
Congratulations on your purchase of a SoftKey ClipArt or picture collection! This manual
covers how to install and use PowerAlbum and the ClipArt or photographic images that
are included with your package.

NOTE:  The terms ClipArt and picture  both refer to any images that are included in this
package.

PowerAlbum allows you to easily organize, manage and view the ClipArt files by presenting
the ClipArt in a format similar to a picture album.

System Requirements

PowerAlbum requires the following hardware and software:

• An IBM 386 or higher
• 4 MB of RAM
• A MPC compatible CD-ROM drive (if you are installing or using files from a

CD) with Microsoft CD-ROM Extensions 2.2 or higher
• A hard disk with 3.4 MB of available space for the program files.
• VGA, SVGA, or greater resolution graphic display card and monitor
• Microsoft compatible mouse
• DOS Version 5.0 or later
• Windows 3.1 or later

Installation

Although you must install PowerAlbum to your hard drive, you can access ClipArt directly
from the CD without installing the files onto your hard disk. There are albums pre-built on
the CD-ROM for use with PowerAlbum. For information about using these albums, see
the Quick Start section

To Install the PowerAlbum from the CD-ROM, please refer to the section Installing the
Programs from the CD.

NOTE: In order to use PowerAlbum with the files from the CD, the CD must be in the
CD drive.

Using PowerAlbum
PowerAlbum uses the metaphor of a picture album. Each page holds up to 12 miniature
representations, or thumbnail images, of graphic files stored on your system. The images
are grouped in categories; you can view two pages of a category at a time.

NOTE:  The ClipArt you purchased with the copy of PowerAlbum may or may not match
the llustrations in this manual.
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Opening Power Album
To open PowerAlbum, double click on the  PowerAlbum icon.

Finding Pictures
There are two ways to search for a picture. The first is to flip through the pages of the
album, as you would through a real photo album. You can browse page-by-page, or jump
to a different category by clicking on its tab. If PowerAlbum cannot display all of the
category tabs, a More tab appears either at the top or bottom of the list. Click on it to
display the next set of tabs for the remaining categories.

The second way to look for a picture is to use the Find Pictures command to search for
pictures with a particular description, file name, or file type.  All of the existing pictures
have descriptions, you can add descriptions to  pictures you place in new albums on your
hard drive.

To use the Find command to find a picture:

1) Choose Find... from the Edit menu.
The Find Picture dialog box is displayed.

2) Type the file name, extension, or the word you want to search for in the Find
What text box.
Enter a whole word, or part of a word. For example, vine finds all file names
and descriptions such as vineyard or ravine.
If you enter two or more words separated by a space, Find searches for all the
pictures whose descriptions contain any of the words. Entering birthday party
locates all pictures with the word birthday in their descriptions, as well as any
with party in their descriptions.

3) Once you've entered text, choose one of the two Find options:
• Click on the Find Next button. It selects the picture and repositions the Find
Picture dialog box so that the picture can be seen. Continue to choose Find Next
until you locate the picture and then click the Cancel button.
• Click on the Find All button and PowerAlbum  locates all the ClipArt,
that match the Find What search criteria and copies them into a temporary category
called Found.  The pictures remain in the Found category until you do another
Find All search.

Viewing a Picture At Actual Size

The pictures you see in the album are all reduced to one size to fit into the frames on the
album page. You can choose to examine a picture in its actual size.

To view a picture in full size:

1) Choose a picture from the album page by clicking on it once.
2) Select Display... from the Picture menu, or press CTRL+D.

If the picture is too large to display in the window, use the scroll bars to see other parts of
the picture or enlarge the display window.  To return to the PowerAlbum window, click
anywhere on the picture.

Placing Pictures

To place a picture from PowerAlbum into another application, copy the picture to the
Clipboard, then paste it into your application.



4

To place a picture in another application:

1) Find the desired picture and select it by clicking it.
2) Choose Copy... from the Edit menu to place a copy of the picture on the Clipboard.
3) Minimize or exit PowerAlbum.

If you plan on using more pictures, you can leave PowerAlbum open and simply minimize
its window or choose PowerAlbum altogether.

4) Switch to the application you want to use and open the document into which you
want to place the picture.

5) Find where you want to put the picture and select Paste... from the Edit menu.
Pictures can be placed into any Windows application document that supports pasting
graphics from the Clipboard.

Shortcut Keys

Some commands have keyboard shortcuts. They are listed here for your reference:

To select the following command Press
Save SHIFT+F12
Save As F12
Exit ALT+F4
Cut CTRL+X
Paste CTRL+V
Find CTRL+F
Add to Album CTRL+A
Display CTRL+D
Help F1

Managing & Organizing Albums

Managing Pictures
This section explains how to add pictures to an album. It also describes how to rearrange,
copy and delete pictures within an album.

Adding Pictures

You can add as many pictures as you want to an album. In order to add pictures you must
either create a new album for those files on your hard disk, or add the pictures to an
existing album using the method described below.

To add Adding pictures to a new or existing category:

1) Select Add to Album... from the Picture menu.
2) Locate the directory containing the images to be added by using the Drives and

Directories list boxes.
3) Select the graphic file format for the type of image you want to add from the List

Files of Type drop-down list.
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You can use wildcards for more varied searches. For example, if you type BDAY*.PCX
and press ENTER, you will locate all the PCX files that start with BDAY. After you type
the search criteria in the File Name text box, press ENTER.

4) Select the files that you want to add to PowerAlbum.
To select adjacent files, highlight a file name and press down the mouse button,
then drag the pointer down the list.
To select non-adjacent files, hold down the CTRL key as you select each file.

To select all the files in the list box, choose the Select All button.You can add all of the
files of the chosen type in subdirectories within the selected directory by toggling-on the
Include all subdirectories check box. Individual pictures cannot be selected with this option.

 NOTE: The more pictures you add, the longer it takes to add them to the selected category.

5) Click on OK and the Select Category dialog box appears.
6) Choose where you would like to place the pictures, either:

Select an existing category in which to place the pictures or choose the Add
Category button to create a new category.

If you choose to create a new category, the Add Category dialog box appears. Type the
name for the new category in the Category name text box and click OK. When you return
to the Select Category dialog box, the new category name is automatically selected.

7) Click on OK.
PowerAlbum imports the selected pictures individually and places them in the chosen
category. When the process is complete, a dialog box appears that reports how many
pictures were selected, and how many were successfully added.

Moving Pictures
You can move a picture to another frame on a page, or to another category. When you move
a picture to another location on a page, the other pictures shift to make room for the one
you moved.

To move a picture to another location on the page:

1) Highlight the picture to be moved by clicking on it.
2) Drag the picture to the location where you want to place the picture.

Only one picture can be selected at a time. The picture appears in the selected
frame. The picture that was in the frame shifts to the right.
There are two ways to move a picture from one category to another.

To move a picture using Cut and Paste:

1) Highlight the picture to be moved by clicking on it.
2) Select Cut ... from the Edit menu.
3) Turn to the page where you want to move the picture, and click on the frame

where you want to place it.
4) Select Paste...  from the Edit menu.

To move a picture using SHIFT+drag:

1) Select the picture you want to move.
2) Holding down the SHIFT key, drag the picture to the new category tab.

The border of the picture becomes a dotted line. If you don’t hold down the
SHIFT key, then you’ll copy the picture instead of moving it.

3) Release the mouse button when the tab is highlighted.
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Copying Pictures

Although you can place a copy of a picture in as many categories as you wish, you can’t
have two copies of the same picture in the same category.

To copy a picture:

1) Select the picture and choose Copy...  from the Edit menu.
2) Turn to the page where you want to copy the picture.
3) Select the frame where you want to place the image.

If you don’t select a frame, PowerAlbum places the picture in the first empty
frame in the category.

4) Select Paste...  from the Edit menu.

NOTE: You can also copy a picture to a category by clicking and dragging it over the tab
of the category to which you want to copy it.

Deleting Pictures

Removing a picture from a category doesn’t delete the graphic file from the hard disk. It
simply means that the picture no longer appears in that category.

To remove a picture from a category:

1) Select the picture and choose Remove From Category...  from the Picture menu.
2) If the picture you select appears in more than one category, you have the option

to either remove the picture from the category only, or the entire album. Simply
click on a button to make your selection or if the picture only occurs once in your
album, click on OK to remove the picture from the category, or Cancel to exit the
dialog box without making any changes.

You can delete a graphic file from the hard disk without leaving PowerAlbum. This is a
permanent deletion and cannot be undone even if you close PowerAlbum without saving
the album.

To delete a picture from the disk:

1) Select the picture and choose Delete File From Disk... from the Picture menu.
2) Click on OK to delete the file.
3) Choose Save... from the File menu to save the change to the album.

If the album isn’t saved, the thumbnail picture is displayed the next time PowerAlbum is
started.

Entering and Editing Descriptions

When a picture is selected, a brief description of it may appear in the Description text box
near the bottom of the album window. Descriptions can easily be created for pictures that
you add or edit for existing pictures.

When you use searches to locate pictures keep in mind that the file descriptions name is
considered part of the description field. For example, for BLACKCAT.PCX, there is no
need to repeat cat in the description.
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To add Descriptions:

1) Select the picture.
2) Click in the description text box and type the new word or phrase.

Separate words by spaces and/or commas, entering up to 64 characters. When
the text fills the field, it automatically scrolls to the right.

3 ) After all the changes or additions have been made, choose Save... from the File
menu to save the description(s).

Managing Categories
Use categories to group pictures by subject, by file type, or by any other desired criterion.
Categories are not static. As your needs change, the album can be modified. You can
rename, add, delete or merge categories at any time. To see a list of all the categories and
the number of pictures in each, click on the Contents tab.

Adding Categories

You can add as many categories as you want to an album and place pictures in several
different categories.

To add a new category:

1) Select Add... from the Category menu.
2) Enter the new category name in the Category name text box.

No duplicate names are allowed. Category names are not case sensitive; the
name sports is the same as the name Sports.

 3) Click on OK.
Alternatively:

You can add new categories while adding pictures.

After you select the pictures to add and are ready to choose a location, you can create a
new category from the Select Category dialog box.

While using the Find All option, you can convert a temporary category to a permanent one.

For more information, see the Using the Find Command section. To make the category
permanent, it must be renamed. For information about renaming categories, see the
following section.

Renaming Categories

You can rename a category from the Contents page or a page in that category.

To rename a category from the Contents page:

1) Select the Contents tab.
2) Highlight the name you want to rename
3) Click on the Category name text box at the bottom of the window and enter the

new name.
To rename a category from a category page:

1) Select Modify... from the Category menu.
2) Edit the name or type a new name over the selected text.
3) Click on OK.
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Deleting Categories

Deleting a category removes both the category and the pictures displayed. When you delete
a category, the graphic files on the hard disk are not affected; they remain in their original
directories. To delete a category but keep the pictures it contains, first copy or merge them
into another category.

To delete a category:

1) If you are on the Contents page, select the name of the category to be deleted.
If you are not on the Contents page, move to the category to be deleted by clicking
on its tab.

2) Select Delete... from the Category menu.
3) Click on OK to delete the category.

Merging Categories

Merging categories copies all the pictures from one category (the Merge From category)
into another (the Merge To category). The original Merge From category remains unchanged.

To merge two catergries:

 1) Choose Merge... from the Category menu.
 2) Choose the category from which you want to copy the pictures from the left-hand

Merge From list.
 3) Choose the category to which you want to copy the pictures from the Merge Into

list on the right.
 4) Click on OK.

Managing Albums
You can create a new album, open an existing album, merge the contents of two albums,
and save changes made to the album.

Multiple albums have a number of advantages as opposed to a single album.

• Multiple albums allow you to break down your categories.  For example, you
can have one album containing business-related pictures, another with pictures
for a volunteer group, and another with pictures for personal documents.

• If you frequently use two or more applications that favor different types of graphic
files, you can create different albums containing pictures of individual file formats.
For example, an album of TIFF pictures and an album of WMF pictures.

• Smaller albums are easier to manage and reduce search time.
• If there are two or more people that use a single computer, each may need separate

albums.

Creating a new Album

 To create a new album:

1 ) Choose New... from the File menu.
If you have not saved any recent changes to the open album, PowerAlbum asks
you if you want to do so.

2) Click on Yes to save the changes, or No to discard them.
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The new album is opened and displayed. It is untitled and contains no categories or pictures.
Before pictures can be added, one or more categories must be added. For information on
adding categories, see the Adding Categories section.

Saving the Album

Once you have created a new album, you must save it in order to give the album a name.

To save an album:

1) Choose Save As... from the File menu.
2) Enter the name of the album in the File Name text box.

PowerAlbum automatically adds the extension .ALB to the file, even if you enter a different
extension.

3) If necessary, choose a different drive and directory in which to locate the album.
4) Click on OK.

Once you have named a file, you can simply select Save... from the File menu to save any
changes you make.

 Opening Another Album

When you open another album, PowerAlbum automatically closes the currently open
album.

To open an existing album:

1) Choose Open... from the File menu.
If you haven’t saved any recent changes to the open album, PowerAlbum asks
you if you want to do so.  Click on Yes to save Opening changes, or No to discard
them.

2) If necessary, choose the drive and directory where the album is located.
3) Highlight the album name you want to open and click on OK.

Merging Albums

When you merge albums, PowerAlbum copies the categories and the contents of an album
into the currently open album.  If a picture appears in both albums, it’s duplicated if it
appears in a category that the open album doesn’t have. If both albums have the same
category, then identical pictures within that category are not duplicated.

To merge albums:

1) Open the album that you want to receive the file.
2) Choose Merge Albums... from the File menu.
3) If necessary, choose a drive and directory to locate the album you want to

merge.
4) Choose the album ( .ALB) file to be copied from the File Name list.
5) Click on OK.

Moving an Album to Another Computer

If you use PowerAlbum on two separate computers and need to move an album from one
computer to another, you must consider these two points:

• Both computers need to have copies of the graphic files referred to in the album
you are moving.
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• To avoid possible problems, the graphic files should have exactly the same path
names.  If a graphic file doesn’t, PowerAlbum searches other directories to find
it when it needs to access the file, but this searching takes time.

An album (an *.ALB file) is an image-index. It keeps track of the location of the graphic
files and lets you identify them by their appearance. An album can be moved to another
computer that has PowerAlbum and the album will still contain all of the thumbnail
images.   However, when you attempt to copy a picture to the Clipboard or to use the
Display command, PowerAlbum looks for the actual graphic file to perform the requested
operation. If the graphic file is not in the same drive and path as it was on the first computer,
you will have to search for it. If it can’t be found on the computer, the operation is
unsuccessful.

Printing a Catalog
You can produce a printed record of all the pictures, by categories, in an album. The
output resembles the pages of the on-screen album, with up to four PowerAlbum screen
pages on a single sheet of paper.  Keep in mind the following guidelines when printing
catalogs:

• You can only print every picture in a category, not individual pictures.
• You can print any combiantion of categories in a single album, including every

category.
• A printed page contains from two to four pages, as shown on the screen. If a

category includes more than four screen pages, additional pages are used.
However, a printed catalog page cannot contain pictures from more than one
category.

• You can print the table of contents for the entire album. Each picture in the
Table of Contents is identified by its file name and description.

• You can choose between two print resolutions:  printer or draft.
Before a catalog can be printed, a printer driver must be installed through the Windows
Control Panel, and you should check your Printer Setup.

NOTE: When using an HP LaserJet Series III printer (IIIP, IIID, IIISI, and so on) HP
LaserJet Series printers, using the HP printer driver supplied with Windows 3.1, you may
experience some difficulties printing catalogs with hundreds of images. Version 2.1 or
higher of the HP printer driver corrects the problem. You can also correct the problem by
using an HP Series II driver. For information on installing printer drivers, refer to your
Microsoft Windows documentation.

To print a catalog:

1) Choose Print Catalog... from the File menu.
2) Select the categories you would like to print.

To select adjacent categories, highlight a name and drag the pointer over the list while
holding down the left mouse button.  To select non-adjacent categories, hold down the
CTRL key while you select categories.  If you choose to print a Table of Contents,
PowerAlbum prints the path name for each picture.

3) If you choose to print a Table of Contents, but do not want to print the complete
path name for each picture, click on the Show path names in Table of Contents
check box to toggle it off (the X is removed).
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4) Choose a printer resolution:  Printer or Draft.
Printer resolution produces clearer images but takes more time than printing in
Draft mode.

5) Click on OK to start printing.

About Graphic File Formats
There are two basic types of graphic files that can be used with PowerAlbum:  Bitmapped
and  Vector  graphics. A  Bitmapped graphic is a collection of dots that form an image,
much like the  technique of the Impressionist painters. When a bitmap picture is resized,
it often distorts the image; the picture looks ragged or the edges are jagged. Vector images,
on the other hand, are defined by mathematical formulas. Unlike bitmaps, vector pictures
can be resized without distorting the image.

BMP and PCX

BMP and PCX are bitmapped file formats created by paint programs like PC Paintbrush
or some screen-capture programs.

CGM

CGM files are a type of vector graphic that can be produced by drawing or spreadsheet
programs such as Harvard Graphics, Applause II, Freelance Plus, and Corel Draw.  The
CGM format was created by the America National Stanards Institute, Inc. (ANSI) to provide
a standard for graphical informatoin exchange, and is widely supported.

DRW

DRW files are vector graphics created by Micrografx programs such as Designer and
Draw.

EPI

Files with the EPI extension are bitmap graphics created by Softkey's TextEffects.  EPI
files are similar to TIF files.

GIF

GIF (Graphic Interchange format) is a file format established by CompuServe.  A GIF file
(usually 256-color) is a bitmapped file.

JPEG

A JPEG file (Joint Photographic Expert Group) is a specially compressed file in bitmapped
format.  The file size of a JPEG file is much smaller than similar pictures in other formats.

PCD

PCD is a Kodak Photo CD file in bitmapped format.  A PCD file actually contains five
different resolutions (ranging from low to high) of a slide of film negative.

TIFF

TIFF stands for Tagged Image File Format.  Files with the TIFF extension are usually
created by scanners or image processing programs.  These bitmapped files come in a
number of different versions.  Because the TIFF format  is so flexible, PowerAlbum may
not be able to successfully handle every file that claims it is TIFF compatible.
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WMF

WMF stands for Window MetaFile.  This is a popular vector format for Windows graphics
files.

WPG

WPG files (WordPerfect Graphic) can be vector or bitmapped graphics.  PowerAlbum
may not read WPG files that contain a combination of vector and bitmapped data.
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Notice

 Copyright © 1994 SoftKey International Inc.
One Athenaeum Street
Cambridge, MA 02139-1901

All rights reserved.

This manual and the software it describes may not be reproduced, in whole or in part, in
any form whatsoever, without the written permission of SoftKey, except for making a
backup copy for archive purposes.

SoftKey is a registered trademark of SoftKey International Inc. PowerAlbum and
TextEffects are trademarks of SoftKey International Inc. Microsoft, MS-DOS, and Windows
are registered trademarks of Microsoft Corporation.

Other product names are trademarks or registered trademarks of their respective companies.

ClipArt images is a trademard of Imageline, Inc. All rights reserved. ClipArt images
International Microcomputer Software Inc. All rights reserved.

Graphics filters is a trademark of Imagemark Software Labs, Inc.  All rights reserved.
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Contacting Technical Support:

If you have questions about the program, consult this manual and the program’s on-line
Help system. If you’re still experiencing difficulty, gather the following information:

• The name of the program you have a questions about.
• The versions of Windows and MS-DOS you’re using.
•  A list of the steps required to replicate the problem.

Contact Technical Support at:

(404) 428-0008  pm Monday through Friday
(Eastern Standard Time)

Send correspondence to:

SoftKey International Technical Support
450 Franklin Road
Suite 100
Marietta, GA 30067

For information regarding replacement diskettes and manuals, contact

Customer Service at:

(800) 227-5609
9:00 am to 6:00 pm Monday through Friday
(Eastern Standard Time)
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The ImagiNation Network

The ImagiNation Network (INN) is much more of a neighborhood than it is a network of
computer game players.  You should treat others on the network with the courtesy and
politeness you would use in any other public place.  Abusive, lewd or obscene language or
suggestive remarks WILL NOT be tolerated in any way and are cause for immediate
removal from the INN   system without notice.  An appeal must be made by phone to INN
headquarters to get back on the system.

The ImagiNation Network does not warrant that service on INN will be uninterrupted or
error-free.  INN is distributed on an “as is” basis without any express or implied warranties.
Neither The ImagiNation Network nor Sierra On-Line will be liable for any damages
arising out of any inability to use INN.

INN is protected by federal copyright law and international treaty. You may not modify or
adapt INN or translate, decompile, or reverse-engineer software running on INN. You
will indemnify   INN against liability for your use of INN and any violation of these rules.

The ImagiNation Network can modify these guidelines at any time by posting the revised
guidelines on INN. Use of INN indicates your understanding and agreement to comply
with these guidelines.

How To Read This Guide
• Menu commands are capitalized, example: TALK, INVITE, LOOK, QUIT
• Typed commands are generally preceded with the word “type”.  For example,

when you are told to type CD\INN, only CD\INN would be typed.
• Keystrokes appear in brackets, example: Spacebar, Tab, Page Up.  The brackets

should not be typed.
• When two or more keys should be pressed at the same time, they are separated

by a hyphen.  The hyphen is not a keystroke and should not be typed, example:
Ctrl-C, Alt-X.

Using Your Mouse
You can use INN with a mouse and a keyboard, or a keyboard only.  If you have a two- or
three-button mouse, the right button i s normally for “Help” and the left button is used to
“point and click”.  If you have a one-button mouse, you can usually get help by holding
down the Shift key while clicking the mouse button.

Throughout this guide, you’ll see the term “click on”.  This means to move the on-screen
arrow (or cursor) to an object and press the left mouse button.  You can move a game piece
by holding the mouse button down, drag the piece by moving the mouse until the piece is
where you want it, then release the button to “drop” the piece.

If you don’t have a mouse, use your arrow keys to move around the screen. To “click on”,
simply press the [Enter] key after you have used the arrow keys to select what you want to
do.  To get help, position your cursor on the feature and press the F1 key.
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Getting Started
Read all on-screen documentation that is available in your I NSTALL program.  This
documentation has important information that may have not been available when this was
originally written.

Installation

NOTE:  You must have a hard drive to install INN.  The installation program will create
a subdirectory on your hard drive called INN (you have the option of overriding the
installation directory).

To Install The ImagiNation Network onto your hard drive, please refer to the section
Installing the Program from the CD.

During the installation the system will ask you for the drive letter of your hard disk.  Enter
the letter designation of your hard disk (usually C:) and follow the prompts.  The system
will ask you for the directory where you want the INN files stored (usually C:\ INN).
Enter the directory name and press Enter.

A system configuration screen will appear and you will need to verify the default choices
for the following (to change defaults, highlight the selection and press Enter to look at the
list of available choices):

• Graphics — indicate here whether you have a 16-color or 256-color video display.
• Sound — There are several sound cards from which you can select.  The

installation program selects the one that seems to be supported by your computer.
The default is the IBM I nternal Speaker.

• Baud Rate — The default is 1200 baud.  If you have a 2400- or 9600-baud
modem, choose the higher speed here.

• COM Port — The default is Com 1.  If your modem is on a d ifferent Com port,
indicate the number here.

• Setup — Unless you are familiar with modem commands, you should accept the
default initialization string that’s given here.  If your modem stubbornly refuses
to respond to this string, see the “Troubleshooting Hints” section.

NOTE: If you have any problems installing INN software, call INN toll-free at 1-800-
IMAGIN-1.  Please have your member ID number handy when you call.  The vast majority
of problems encountered when first-time users attempt to log on to INN are from modem
compatibility problems.  If you cannot access INN after completing installation, please
have your modem manual handy and call INN toll-free at 1-800-IMAGIN-1.

• Access Phone # — The INN software includes a list of current carrier access
numbers.  Highlight ACCESS PHONE # and press Enter.  Then press F1 to look
through the phone list of cities in your area code.  After entering your area code,
select the phone number for the city nearest your location.

NOTE:  You will be responsible for any toll or message charges you incur while using
The ImagiNation Network.  Please call your local operator to verify that any number you
select is a local call for you.  If you have any questions, call INN’s Member Services
Department at 1-800- IMAGIN-1.  Please have your member ID number handy when you
call.
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If you have CALL WAITING, you WILL lose connection to INN if you receive a second
call.  To avoid this inconvenience, check with your local telephone company for instructions
on how you can disable CALL WAITING.  In most areas entering “*70” before your local
access number will disable call w aiting for that one call.  Your call waiting feature should
automatically return as soon as you exit INN.

• Touch Tone — Indicate whether you have a touch tone service on your phone.
• Member Number — Look in your INN package for a label marked Member

Number (or copy it from your prior installation s creen).  Enter this number in
the appropriate box on the installation screen.  Keep this number secret and do
not give it to anyone.  Any charges incurred on INN will be the responsibility of
the owner of this number.

• Passwords — You must choose one of two methods for using passwords.  If you
choose the UNSECURED METHOD, you will be prompted for a password that
will be recorded onto your h ard disk.  When you dial in to INN for the first time,
the password you recorded onto your hard disk will be uploaded to INN.  From
that point forward, whenever you log on to INN, your password will be
automatically transmitted to INN.  If it is the same one as the one recorded at
INN, you will be allowed access.  If not, access will be denied. To change your
password, you must log on to INN and select the CHANGE PASSWORD option.

If you choose the SECURED METHOD, you will simply be prompted for your password
every time you log on to INN.  If the password you type matches the one you entered
during your first session, you will be allowed access.  If not, access will be denied.  To
change your password, you must log on to INN and select the CHANGE PASSWORD
option, which is located in the Town Hall on the INN main map.

It is highly recommended that you use the SECURED METHOD in order to ensure that no
unauthorized use of, or charges to, your INN account occur.  You can change from one
method to the other at any time.  However, to do so, you must go through the Install
procedure again.  To make sure you will be allowed access to the system after the change,
make sure that you initially use the same password for the new method as you used for the
old.  After the first time you log on with the new method, you can then change your
password as above.

Accessing The ImagiNation Network
When you have completed the installation sequence and set the system parameters from
the default list, you’re ready to run the program.

1) From your system root directory, type  CD\INN (or the name of your INN directory)
and then press Enter.

2) Type INN then press Enter.
Congratulations!  You’ve just moved into the world’s friendliest electronic neighborhood.

Creating A Persona
Your on-screen persona represents you when you go on-line on INN. Your persona includes
a face and a list of personal interests, games you like, and your skill level.  Its purpose is
to let people know what you’re like and a great way for people with similar interests and
skills to get together and have fun!
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For each INN account, you can create several different persona to represent the different
members of your household, or to role-play as different persons and personalities. Left-
Click on the CREATE button to begin creating your persona.

Information About Yourself

 The program will ask you to type in a name, age and city.  HINT: Real information will
make it easier for people to find you and get to know you. Fill i n your information then
click on OK to continue.  Now you can customize your profile, including creating the face
that other INN members will see.

How Others Will See Me

By clicking on the right and left arrows of each category you can change features of your
face. Experiment and have fun!  When you’re satisfied with the way your face will appear,
click on GO ON.  The next screen lets you tell other people about your skill and interest
levels for each game.

My Game Skills

The Clubhouse includes many games: BACKGAMMON, CHESS, CHECKERS,
CRIBBAGE, HEARTS, BRIDGE, GO, SPADES, EUCHRE, and FLIPFLOP (popularly
known as Reversi). As you click and hold on each game, slide the i ndicator to your skill
level and release the mouse button.

My Hobbies and General Interests

You can click on up to four hobbies and general interests from two screens of alphabetical
interest choices. When you’re done, click on GO ON.

You now see your on-line face, personality and game preference profile the way other INN
members will see it.  If you’re happy with this version of yourself, click on SAVE to return
to the Title Screen.  If you want to make some changes, click on GO BACK.

Now, if you want, you can create another alter-ego or a persona for another member of
your family.  Or, select a persona and then click on PLAY.

Dialing and The INN Map

The first thing you’ll see after running The ImagiNation Network program is a dialing
screen with a password prompt window.  Type your password and press Enter.  Your
modem will automatically dial INN.  When you’re connected, you’ll see a B illing Status
window.  Press Enter and you’ll soon see a map of the locations within INN.  Before you
play, you should get to know your way around the INN Map.

Mail (post office):  You can access your personal mailbox here and can send (optional)
and receive letters from your friends on INN at any time.  If you have mail waiting, a
flashing envelope will appear over the post office.

Town Hall (HELP arrow points to it):  You can get help about INN (both written and
on-line) in the Town Hall.  Other options l et you check your billing information, change
your password, leave messages for Member Services, and print INN game manuals.  If
you have a question about INN, chances are good that you can find your answer in the
Town Hall.
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INN Clubhouse (wooden building at bottom of screen):  This is a great place to go to
play a variety of board and card games, talk to people, access the Sierra family of games
hint files, go to conference rooms and read/leave messages on the many bulletin boards.

Casinoland (casino in upper left corner of map):  This is a completely different self-
contained environment for adults in INN. Access is restricted from CasinoLand from the
basic INN system. Here adults can play Blackjack, Poker, Roulette and Slots, and spend
time in Lefty’s Bar talking to other adults and playing bar games.

Sierraland (castle in middle right of map):  This is also a self-contained world within
INN.  SierraLand is fun for both k ids and adults, and features games like Red Baron,
MiniGolf, PaintBall, NTN Trivia, and Graffiti (an intuitive painting program).  SierraLand
is the family fun center of INN.

Medievaland (volcano):  This is where players can go to play The Shadow of Yserbius,
and Fates of Twinion. These incredible role-playing games let you join other INN friends
to explore the depths of mysterious volcanos in search of magic items and the solution to
the mystery of events surrounding the volcanos.

Find Member (telephone booth):  If you’re looking for a friend and don’t know where
he/she is on INN, if at all, click on the phone booth and a window will prompt you for the
person’s on-line name.  If they are on INN, it will tell you their location.

School (schoolhouse):  In a future upgrade of INN, this area will contain activities and
games which are both fun and educational.  Look for more about this later.

Post Office:  Keep in touch with all of the new friends you’ve met on Imagination via
electronic mail (E-Mail).

Mall (Shop Sign):  Members are able to purchase INN, Sierra family of games merchandise,
as well as items from other participating retailers - right from their own computer!

INN Credits (INN water tower):  Click on this water tower to see everyone who worked
hard to make sure you have fun on INN.

EXIT:  Click on the EXIT sign in the bottom of the map to exit INN and return to the DOS
prompt.  Come back real soon!

Now that you know how to get around the INN Map and what each place represents, it’s
time to have fun.  It’s best to try out the INN Clubhouse first to get used to the commands
and options in INN. The next sections will help you get started in the Clubhouse. Look at
CLUBHOUS.DOC, SIERRLND.DOC, CASLAND.DOC, and the YSERBIUS.DOC files
if you need more specific information for those lands.

Entering The Clubhouse
Left-Click on the INN Clubhouse on the INN Map and you’ll be presented with a list of
places where you can meet people, play g ames and access all the many bulletin boards.
After you have selected a place, you will be asked to choose the games that you are interested
in playing during your session. Other members will use this information so that they can
arrange to invite you to play a game. After you press the “OK” button, you will enter the
waiting room.

If you don’t see the Waiting Room screen within two minutes or so, there may be a
communications problem. The access number y our computer dialed may be busy. Or,
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someone may have picked up an extension phone on the same line as your modem. Or
perhaps you didn’t disable CALL WAITING.  If you continue to have a problem, please
call INN toll-free at 1-800-IMAGIN-1.

The Waiting Room

The Waiting Room is where you meet other people, LOOK at their persona profiles, TALK
to them, INVITE them to play games, or WATCH a game that’s currently in progress.

In the lower portion of your screen, you will see a text bar that gives you information such
as the time, how many people are on your host, and give you readouts on your information
requests.

Making friends is easy.  Just select a person by left-clicking on the box with his or her
name.  The box will change from yellow (not selected) to red (selected).  If you want to
select all of the people in the Waiting Room who are not involved in an activity, click on
the ALL button.  To deselect a person, click on the name box again. It will turn from red to
yellow.  To deselect all people, click on NONE.

When a person is involved in a game, in the Bulletin Board or w atching a game, a descriptive
icon appears to the left of his or her name.  This shows you what the person is doing.  You
can easily get definitions of what particular icons mean by clicking on HELP in the
OPTIONS menu and then selecting WAITING ROOM and then LEGEND for definitions.

If there is no symbol next to a person’s name, it means the person is not playing a game,
watching, or reading the Bulletin Board. They could, however, be involved in a conversation
and may not respond immediately.

Talking To Friends On INN

Talking to others is easy in the INN Waiting Room.  Just click o n their name tags, and then
click on TALK. A dialogue box will appear.  Type your message and press Enter.  You can
save the step of clicking on TALK by simply selecting a person and then typing.

NOTE: Your message will be seen by all those you have selected.  You can talk to other
people whether or not they are involved i n a game or reading the Bulletin Board — unless
they have PRIVACY turned on.  More about that later.  If you type a mistake, normal text
editing commands work until you actually send the message.

When others talk to you, you are given the choice to REPLY, COMPLAIN, MUTE, or
simply press OK (to get rid of the message without responding). When you click on REPLY,
you will be offered a box to type your reply. You reply will only be sent to the person who
spoke to you even if you have many others selected. The MUTE button will allow you to
block all messages from anyone who sends you annoying or offensive messages. You may
also use the COMPLAIN button which will send the truly offensive message sent to you to
INN personell for their review and possible disciplinary action.

LOOK

LOOK lets you learn about your new neighbors.  Select the person you’re interested in
and click on LOOK or simply move your cursor to a name and click on the right button of
your mouse or press [F1].  The person’s picture, skill levels and other information will be
displayed.  You can tell what games they are interested in playing by looking for a yellow
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check mark next to the games.  Also, you’ll notice on the person’s profile a box labeled
ADD TO ADDR.  If you click on this box, the Mailbox address of the person you are
looking at will be added to your INN electronic address book (detailed later in this manual).

If you select more than one other person to look at, you can scroll rapidly through all the
profiles by simply clicking on the LEFT ARROW OR RIGHT ARROW buttons.  When
you’re ready to leave the LOOK screen, click on OK.  You can look at yourself by clicking
on OPTIONS and then on WHO AM I.  If you want to SORT the names in alphabetical
order in the waiting room, click on OPTIONS and then SORT NAMES (or press Alt-R) to
do this.

INVITING

To play a game you must either invite someone to play with you, or be invited.  To invite
someone to play, first click on the name tags of the people you want to play with.  Then
click on INVITE and a control panel will appear with a list of all available games.

You can now click on the game you want to play.  The person (or persons) you have
selected will receive an invitation to play the game you’ve chosen.  If they accept your
invitation, the screen will automatically display the game board you’ve selected.

Of course, if people are already playing or watching a game, they can’t play with you.  If
someone is reading messages in the Bulletin Board, they must first return to the Waiting
Room before you can invite them.

If one or more of your INN friends declines your invitation, a text box appears declining
your offer.  If you receive no response in a reasonable length of time, or you change your
mind, just click on CANCEL.  Note: if there is no response to your invitation, you must
cancel the invitation before you can do anything else.

Responding To An Invitation

When you are in the Waiting Room, you’ll probably receive an invitation to play a game or
join in a Chat Room.

You respond by clicking on ACCEPT or DECLINE.  You can also click on LOOK to see
your potential opponent’s profile and skill level before sending your reply.  If you are
invited to join a multiple-player game, you can look at everyone’s profile before responding.
If you decline the invitation, a text box appears where you can provide an explanation.

While You Play

To talk with the people you are playing a game with, simply begin typing. A dialogue box
will appear with your text, then simply press [Enter] to send your message.  All players in
the game will be able to view your message.

When you’re playing a game, the OPTIONS menu will often include options just for that
game.  It’s a good idea to familiarize yourself with these menus as you play the game.  You
activate the menu by moving the cursor to the OPTIONS button on the s creen, then clicking
the left mouse button or pressing Enter.

WATCHING

To watch a game in progress, first select the player you want to watch and click on WATCH.
The selected player will be informed that you would like to watch as they play.  Your
request will be accepted or denied.
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While you’re watching a game, you can send messages to the players. Just start typing and
a dialogue box appears.  Each message you type goes to all players in the game, so be
careful not to reveal confidential information, such as the cards a layer is holding in his
hand.

Please be considerate of the feelings of the players, and keep messages to a minimum to
avoid distractions.  If you become disruptive to the game, any of the players has the ability
to return you to the Waiting Room.  When you’ve finished watching, simply choose LEAVE
GAME from the Game Options menu.

While you are playing, you may receive requests from others to w atch your game. If you
know from the start that you don’t want to be watched, you can activate the PRIVACY
feature in the Preferences submenu from the Options menu.  All requests to watch your
game will be politely denied.  However, someone else in the game can still allow others to
watch.

If an eyeball appears on your screen during a game, it simply means that someone is
watching your game.  All players have the right to allow others to watch, as well as the
right to stop others from watching.  To see who is watching, click on the eyeball.  If you
want to stop someone from watching, click on the eyeball and choose the person you want
to stop watching.

Going Places With The Go To Button

While in the Waiting Room you can click on the GO TO button for access to a variety of
activities. Each land has different items i n the GO TO button. One option in the GO TO
button is “A PERSON”.  This option helps you find specific people and people interested
in playing specific games.  LOCATE PERSON will select the name tag of the player you
specify.  This is handy if there are a large number of players in your room.  MATCH
GAME INTERESTS will show you a list of players with matching interests.  You can look
at the list of players or select one or more.  Then you can TALK to them or INVITE them
to play a game with you.

Post Office
INN’s electronic mail (E-Mail) service works just like the Post Office.  You get a private
mailbox where you can pick up your letters.  You can get HELP by clicking with the right
mouse button on anything you’re unsure about.

A good way to explore electronic mail is to write yourself a letter.  Click on WRITE A
LETTER and you will see an envelope ready to be addressed.  Type in your on-line name
in the return address area.  Then tab to the address area and type your name and Box #.  If
you decide against sending your letter, click on FORGET IT to return to the mailbox
screen.  You can change the stamp on the letter by clicking on it.

Note: When you’re addressing an envelope, clicking on an entry in your address book
automatically addresses the envelope with  that address.  See “Your Personal Address
Book” below.

Clicking on TYPE LETTER shows you the first blank page of your letter.  Type your letter
using all normal editing functions.  When you reach the bottom of the first page, click on
the arrow to go on to the next page.
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LOAD A LETTER lets you create a letter off-line and upload it into electronic mail.  All
such off-line letters must be in ASCII text format. If there is no blank space before a
carriage return, it is assumed to be the end of a paragraph.

When you’re done, click on MAIL THIS LETTER.  A confirming message window appears
letting you know your letter arrived at its destination.  Click on OK to close the message
window.  Click on RETURN TO ENVELOPES  to return to the mailbox screen.  If you’re
using a keyboard without a mouse, you must use [Tab] or [Esc] to get to the control buttons
on the right side of the screen.  The left arrow returns you to the letter.

To read the letter you’ve just sent yourself, or a letter someone else has sent to you, click
on the envelope and then click on READ A LETTER (or double-click on the letter).  When
you’re done, you can throw the letter away, save it to your disk, reply to it, or forward it to
another box.  You can also discard mail without reading it by clicking on the letter you
want to get rid of and then clicking on the DISCARD button.

You can also set AUTO-SAVE from the OPTIONS menu so that all mail you read
automatically gets saved to a file named EMINPUT.TXT and all mail you send gets saved
to a file named EMOUTPUT.TXT.

Your Personal Address Book
INN supplies you with a personal on-line address book that you can use to store mailing
addresses of other INN members.  When you’re not at your mailbox you can still get to
your address book through the OPTIONS menu.

Adding a new address to your book is easy.  Simply click on an empty space in the book.
You can then type in the new address.

Entries are automatically sorted in alphabetical order.  To leave the address book, click on
CLOSE at the left of the book.

Exercise Your Options
The Options menu gives you many options that make INN even easier and more fun.  To
see the Options menu, click on the OPTIONS button.  You will see a series of new
buttons:

1) PREFERENCES accesses an entirely new menu that has important functions for
customizing your environment on INN.
•   PAGING alerts you during games or other activities when other people log
into the place you are in.
•   PRIVACY denies all requests by others to WATCH your game or TALK to you
while you are not in the Waiting Room.
•   MESSAGE DELAY adjusts the length of time a message remains on-screen.
Moving the lever to the right [+] lengthens the time messages are displayed.
Moving the lever to the left [-] shortens the display time.
•   VOLUME adjusts the sound level.  Move the box to the left for a lower sound
level and to the right to raise the level.

NOTE: If you don’t have a sound card and are using the computer’s speaker, there is no
volume adjustment available, but you can accomplish on/off with this adjustment.
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•   SAMPLE TEXT color bars above and below the words “Sample t ext” let you
adjust the colors of your text and message boxes. All messages you send to
others will appear in the colors you select.  Your colors are as distinctive to
people on INN as your name, so choose ones that you like and plan to stay with
so people can recognize you from your text colors alone.

2) The clock can be switched back and forth between elapsed t ime on-line for the
current session and the current time as set on your computer’s clock.  Click on
the clock to make this switch.

3) HELP gives you general information about the area you are in.
4) ABOUT tells you who the interesting people are that created this version of

INN, tells you what version of the program you’re using, and tells you the baud-
rate at which you are connected.

5) QUIT gives you the choice of returning to the persona creation screen, the INN
Map or quitting to DOS.

6) WANT TO PLAY lets you change the games you’re interested in playing during
this session.

7) WHO AM I displays your own persona.
8) CURSOR lets you select your normal and waiting cursors.

CasinoLand and SierraLand also let you choose the cursor you want.

There are also special symbols that you can use in INN text messages and mail by pressing
the ALT key and one of the numbers from 1 through 0 on your keyboard, NOT your
keypad.  You can add smiley faces and hearts to your messages with these key sequences.

Help
Getting help in ImagiNation is easy.  For general information, simply click on the HELP
button in the Options control panel.  Several screens of helpful text will be displayed.  If
you need help information about a specific menu item, simply p oint at the item (for example,
the TALK button) and click.  Use the right-side mouse button if you’re using a two-button
mouse.  If your mouse has just one button, hold down the [Shift] key and click on the
selection.  A message will appear telling you how to use the selected feature. Don’t forget
that INN is a friendly neighborhood, so don’t hesitate to ask your neighbors for help.

The INN Sysop Staff
In order to ensure that everyone has the best time and most fun possible on INN, you will
frequently see people in the waiting room or elsewhere that have the letters “ INN” at the
begINNing of their names (e.g., INNLynn). These are the SysOps, the “guardians of our
fun.”  They function as the social directors and police force of INN.

Whenever you’re on INN and have a question, feel free to ask a SysOp.  They can direct
you to people who share your interests, and advise you on system operation.

Troubleshooting and Hints
If you encounter other difficulties while using INN, try the following steps:

1) Between 8 AM and 10 PM (PST) M-F call Member Services toll-free:
1-800-IMAGIN-1.
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NOTE: This number is ONLY for INN business. When you call this number for technical
support, it helps if you are at your computer with the f ollowing information and references
at your fingertips:

 • Your Membership ID number
 • The access number you call
 • Your processor type and speed (e.g. 386 25MHz)
 • Your modem make, model, baud rate, and if possible have your modem manual

with you.
There are four files which are often useful in diagnosing technical problems.  The two that
we need most often are in your INN directory.  It can save us time if you can have the
contents of your TSN.CFG file and your LSCI.CFG file typed out and ready for reference.
The other two files which are often useful are located in your root directory.

It can aid diagnosis to know the contents of the CONFIG.SYS and AUTOEXEC.BAT
files.  Whenever possible, write down the error message you receive exactly as it appears,
along with any details which d escribe the problem.

2) You can reach the Sierra On-Line Bulletin Board at the f ollowing number: (209)
683-4463.  The settings are 300, 1 200, 2400 or 9600 baud; 8 Data Bits; No
Parity; 1 Stop Bit.

INN's Golden Rules
INN is a public place.  There are definite rules of conduct which all participants must
recognize and observe.  The most important is very simple: Don’t infringe on the rights
and enjoyment of others.

Obscenities and blatant lewdness are not acceptable except in t he unrestricted areas of
CasinoLand.  A complaint about this t ype of language may result in immediate loss of
INN access and membership privileges.

You may register a complaint with INN by clicking on the COMPLAIN button located on
the offensive message.  A Complaint Window opens which shows you what will be sent to
the INN Host Bulletin area. You may type a personal comment at this time which will be
seen by the Host.

Please be aware that complaints are taken seriously by INN.  Registering a complaint may
result in the loss of INN access and all system privileges for the person you are complaining
about. You should also know that nuisance complaints can have the same effect for the
person issuing the complaint.

Broadcasting obscenities or lewd comments to others on the system, or even within a
Waiting or Conference Room, is cause for immediate dismissal.

Sending messages repeatedly, or sending them so fast that the other person cannot play a
game or enjoy a conversation with someone else is also cause for the INN Host to log you
out immediately.  You may be able to get back on the network (unless you persist in this
behavior), but anytime you must be logged out by the Host, a warning will be issued.

When using the Bulletin Boards please use good taste and common sense in what you
post.  Obscenities will be deleted and the person posting the message will receive a warning.
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The Bulletin Boards are not intended as an advertising medium.  Ads will be removed
mmediately and the member who posted it may lose INN membership privileges.

Common Sense Etiquette
Follow this rule and you can’t go wrong — treat others the way you would like to be
treated. When playing games, please observe the basic rules of good sportsmanship.  This
includes playing games to their conclusion, even if you are losing.  If you must leave a
game in progress, always give your opponent a reason.  Never leave abruptly without an
explanation.

When you are watching a game, be courteous to the players. Many messages during a
game can be distracting.  Remember, too, that any participant has the right to prevent you
from watching further.  And if you talk during a game, be careful not to give away information
about a player’s hand or position.

It’s a lot of fun to come in and say hello to your friends or say goodbye before leaving.  This
is encouraged.  We do not encourage, however, clicking on ALL or selecting everyone
individually and saying hello without first checking to see whether they are engaged in
another activity.

Many people get deeply involved with games and resent i ntrusions into their concentration.
There are other participants who may be easily confused by a lot of messages while they
are playing a game or reading the Bulletin Board.  It is not courteous to these people to
subject them to this kind of message.

People often cannot play a game for a variety of reasons, or p erhaps they simply prefer to
stay in the Waiting Room to chat.  If you invite someone to play a game and are refused,
please accept the response gracefully and attempt to find someone else to play with.  If no
one is interested at the moment, stick around! Someone will show up.  Always remember
that it’s much easier to find playing partners when you have a reputation for courtesy and
good sportsmanship.

Think of INN as a social gathering place, where lasting friendships can be made — or
where friendships may be jeopardized by discourteous behavior.  Now that you’re clear on
the rules, GET ON INN AND HAVE SOME FUN!

Common Problems & Solutions
This following information was developed after the ImagiNation Network manual was
printed.  If you’re having difficulty installing or running INN, please read this document
carefully.

Can't Hear The Modem Dial

If you can’t hear the modem pick up the phone and dial, then INN is having trouble finding
your modem.  You may need to change the COM port setting for INN.  To do this, go into
the directory into which you installed the INN software, run the Install program, and
choose “COM Port” from the menu and select a different check marked selection.
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Not Enough Memory

If you get the message “Not Enough Memory...” before starting INN or during game play,
you need to make a DOS Boot Disk.  A Boot Disk will create an optimal setup for your
computer to install and play INN.

To make a INN Boot Disk run the program BOOTDISK.EXE from either the #1 diskette
(if you haven’t already installed the software) or from the directory into which you installed
the INN software.  After creating the Boot Disk, restart your computer with the Boot Disk
still in the A: drive.

INN Gives An Error #12

Make sure you’ve chosen the modem brand that you have installed in your computer.  You
can re-run the Install program to check what brand modem you have installed and change
it to the correct brand if necessary.  For additional information on this problem, see the
technical information on Error #12 below.

Suffering From Excessive Disconnections

If you are finding you are getting disconnected from the ImagiNation Network an excessive
number of times, and specified 9600 baud as your communication speed in the Install
program, try re-running the Install and change your communication speed setting to 2400
baud instead.  More times than not, this will solve the problem.

Additional Technical Information

Non-Standard IRQ And COM Port Configurations

If you have a non-standard IRQ setting for your modem, run the Install program and change
the COM Port setting by moving the highlight bar to the COM Port line, hit Enter, and
choose “Non-standard...” at the bottom of the COM port list.

NOTE: You will always be told that your system does not appear to support this choice.
This is the nature of a non-standard system and should not be cause for alarm.

You will then be prompted for the IRQ and I/O Address settings.  If you are unsure as to
what you need to select, just hit F1 for Help and you will be given information that should
help you in determining the proper answers for these prompts.

Remember, in most cases you cannot adversely affect your system in any way by making
an incorrect selection, at worse you will simply have to re-run this process and indicate a
different selection.

More About COM Ports

If you have an internal modem, please examine the COM port settings of any previously
installed Asynchronous Communications Adapters (ASYNC) or multi-function boards, as
well as the COM port setting of the internal modem, to ensure there are no addressing
conflicts.

COM ports 1 and 3 share IRQ #4.  COM ports 2 and 4 share IRQ #3. We recommend that
if you have a mouse on COM 1 you should set your internal modem to COM 2.  If another
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device in your computer conflicts with COM 2, try setting your modem to COM 4.  Avoid
using COM 3 if you have a serial mouse on COM 1.

More About Boot Disks

A Boot Disk will allow you to bypass your computer’s normal configuration to create an
optimal environment for installing and playing INN.  To make a INN Boot Disk, run the
OOTDISK.EXE program from either Disk #1 (if you have not already installed INN) or
from the directory into which INN is installed.  After creating the Boot Disk, restart your
computer with the Boot Disk in the A: drive.

A Boot Disk will not alter your existing system configuration.  Your computer is designed
to recognize a Boot Disk in the A: drive as an alternate method of starting and configuring
itself.  You might think of the Boot Disk as your INN Startup Disk.  It’s the best method
we have of ensuring that your memory configuration is set to best run INN.

Sound Blaster-AdLib

Since INN uses mostly FM synthesis music, you can eliminate many Sound Blaster conflicts
by simply choosing AdLib as your music device in the Install program.

Of Mice & Modems

If you have an internal modem and a serial mouse you must make sure that they aren’t
both using the same COM port.  Your modem and mouse each need their own COM ports
and IRQ interrupts.  Setting both mouse and modem to the same COM port or interrupt
may cause problems.  Changing your modem to COM 2 or COM 4 (see your modem
instruction manual for directions) should resolve most conflicts.

An Enemy Plane Shot Down My Mouse

Occasionally, on a few brands of computers, you might find that your mouse is misbehaving
after a game of Red Baron.  Perhaps every time you click on something, you get help
instead of actually doing what you told your computer to do.  What’s happening is that
your computer thinks you are pressing one of the shift keys.  You can fix the problem by
pressing and releasing the two shift keys (you don’t have to press them at the same time.
Just press and release each one).

I Can't Get There From Here (Reconnect Failure)

When you move from one area to another on INN you actually change from one host
machine to another.  Although you can’t see it, your software tells the network to disconnect
you from your current host machine and connect you to another one.  In order for the
network to get the message to move you, it must receive a break signal from your modem.

If your modem isn’t configured properly, the break signal may not be passed through to the
network properly.  If this occurs you will see a “Reconnect failure” error message and INN
will automatically re-dial the modem to re-establish your connection.  Most often the
solution is to add a command to the modem initialization string that changes the way
break signals are handled.

The Install program has a list of initialization strings for various makes and models of
modems.  Check for yours in the “Modem model” section of the program.  If your modem
is not listed, start by choosing “ImagiNation Network Default Settings”.  If that doesn’t
work with your modem, try one of the two “Generic” switchless modems.
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Some modems designed with Rockwell ROM chips have problems sending a break signal
due to the design of the control chips.  The two modems best known to exhibit this behavior
are the Boca 14.4K internal Fax modem and the Gateway Telepath internal 14.4K Fax
modem.

Our programmers have designed an alternate modem driver that works around this hardware
problem.  While this replacement driver was designed specifically for the Boca and Gateway
modems, other 14.4K internal fax modems that use a Rockwell chipset may benefit.  You
can choose this driver by selecting “Generic switchless (alternate)” in the “Modem model”
section of the Install program.

9600 BPS V.32 Connections

In order for INN to successfully connect and reconnect you must disable MNP 5 error
correction.  Our modem initialization strings automatically disable MNP.  If your modem
isn’t listed in our setup strings check your modem manual, or call your modem manufacturer,
and insert the control codes to disable MNP 5 error correction.

A Few Words About Virtual Memory

With our ever-increasing variety and attention to detail, things just got a little big.  So we
needed more memory.  Well, we looked really hard, and we found a couple of ways to get
it.  One way is what we call Virtual Memory (VM to its closest friends).

If our software finds that your are running low on available conventional memory (less
than 580K), it will attempt to use any available Extended memory (XMS) or Expanded
memory (EMS) your computer may have.  The Virtual Memory system requires a minimum
of 311,296 bytes of XMS or EMS memory.  It can use up to 1,048,576 bytes of XMS or
EMS if available.  Our Boot Disk Maker (BOOTDISK.EXE) will attempt to install an
XMS manager if you have DOS 5.0 or higher.

If you do not have enough available XMS or EMS memory, the Virtual Memory feature
will use some of the space on your hard disk for temporary storage, in much the same way
that Microsoft Windows (tm) uses its temporary swap files.  This works as long as you
have at least one megabyte of available space on your hard disk.  But it has one drawback
- it can seem slow at times.  You’ll know that VM is active because your cursor will look
like a 3.5" diskette.

Volume Control

Have you heard the opening music for INN so many times that you’re humming it in the
shower?  Have the neighbors called asking that you turn down the map music?  Well, now
you can either turn the music down, or turn it off altogether.  To accomplish this you
simply need to add the line LOGONVOL=0 to the LSCI.CFG file on your hard disk.  This
will shut the music off in the dialing screen and the map.  If you wish to lower it, simply
increase the number from 0.   The maximum volume is 127.  After you are done editing the
LSCI.CFG file, run the INSTALL program and choose “Accept these choices and save
configuration” without changing any of the values.  From then on, the music and sound
effects you hear when logging on will be turned off.
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Seasons

INN has seasonal maps! If at any time you would like to restore the original INN main
map, you may add the following line to the LSCI.CFG file in your INN directory:

SEASONS=OFF

To turn seasons back on, either remove that line or replace the word OFF with ON.  To
force INN to show a particular season, replace the word OFF or ON with WINTER, SPRING,
SUMMER, or FALL.

Make sure to run the INSTALL program after making any changes.  When you see the
main menu of the INSTALL program, select “Accept these choices and save configuration”
to save the new settings.  This will compleate and save the changes you made.  Otherwise
you may notice that when you go from land to land the map screen changes.

Unless you have specified a particular season, the seasons are dependent on your computer’s
internal clock setting.  If your computers’ internal clock is wrong, the seasons will not
change correctly.

Error Messages and Their Meanings

ERROR #1

The connection to INN has been lost.  Check to make sure that someone else in your
household isn’t attempting to log on to INN using the same Member number.  If two
people log on at the same time using the same number they will both be dropped.

ERROR #8

The system that lets you reach out and touch INN is busy at the phone number you chose
during the installation process.  If you wait a few minutes and try connecting again, you
should be able to get through.

If the number nearest you is busy on a regular basis, please call 1-800-462-4461 (between
8:00 am and 10:00 pm PST, seven days a week) and report the busy phone number.

In the interim you can try calling another nearby access node, but YOU WILL BE
RESPONSIBLE FOR ANY TOLL OR LONG-DISTANCE CHARGES. Run the Install
program from the directory into which you installed INN, choose “Access Phone #”, and
press F1 for a list of local access numbers.

ERROR #9

First, double-check the Network access number you chose for INN to call.  Make sure
you’ve selected an access number from the list in the INSTALL program.

If you cannot hear your modem pick up the phone and dial, the “COM Port” setting in the
Install program may be incorrect.  Check which COM port your modem is using, re-run
Install and choose that COM port.  Also, check to make sure your phone line is plugged
into the modem.

If you have an internal modem, and if you can hear the modem go off hook, dial, and
connect, but you still get Error #9, try changing the COM port the modem uses.  If your
modem is set to COM 2 or COM 3 try changing to COM 4.  Check your modem manual for
the proper switch settings or jumper positions to change the COM port on the modem.
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ERROR #10

Verify the network access number by running the INSTALL program.  If you have selected
a valid network access number, then the system that lets you reach out and touch INN may
be experiencing network trouble.  If the problem persists for more than a few minutes, call
1-800-462-4461 (between 8:00 am and 10:00 pm PST, seven days a week) and report the
problem, including the number you are calling, so that we can get it fixed.

In the interim you can try calling another nearby access node, but YOU WILL BE
RESPONSIBLE FOR ANY TOLL OR LONG-DISTANCE CHARGES.  Run the Install
program in the directory into which you installed INN directory, choose “Access Phone #”,
and press F1 for a list of local access numbers.

ERROR #12

Your modem initialization string may need modification.  INN works best if MNP 5 error
correction is disabled.  If your modem is not on the list of modem models in the Install
program and the default choice gives you this error, check your modem manual for the
initialization command that disables MNP error correction.  While advanced modem
commands vary, often this command is AT&Q0 or AT\N0.  If you are unable to find the
commands to disable MNP error correction please call INN Tech Support at 1-800-462-
4461 between 8:00 am and 10:00 pm PST, seven days a week.

ERROR #13

The system that lets you reach out and touch INN may be experiencing network trouble.  If
the problem persists for more than a few minutes, please call 1-800-462-4461 (between
8:00 am and 10:00 pm PST, seven days a week) and report the problem, including the
number you are calling, so that we can get it fixed.

In the interim you can try calling another nearby access node, but YOU WILL BE
RESPONSIBLE FOR ANY TOLL OR LONG-DISTANCE CHARGES.  Run the Install
program in the directory into which you installed INN and press F1 in the access number
screen for a list of local access numbers.

ERROR #21

Reconnection Failure can be caused by two conditions.  First, check your modem
initialization line to make sure that the modem init string disables MNP error correction.
Second, if your modem has the Rockwell ROM chips you may need to use the alternate
modem driver. If you are receiving this error and your modem does not appear on the
modem model list in the Install program, please call 1-800-462-4461 (between 8:00 am
and 10:00 pm PST, seven days a week).

ERROR #999

This indicates that you have encountered an unknown problem and the system was unable
to determine what went wrong.  This error message indicates that something unusual that
the software cannot identify occurred on your system.  Check your system configuration
for COM port conflicts and available memory.  If you have an external modem your serial
cable may be defective.  Try switching serial cables and see if the problem persists.  If you
continue to get this error please call 1-800-462-4461 (between 8:00 am and 10:00 pm
PST, seven days a week).
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Unable To Load Video Driver

This indicates that the LSCI.CFG file in the directory into which you have installed the
INN software has been damaged.  To fix this run the Install program, make sure the Video
option is set correctly, and choose “Accept these choices”.  This will re-write the LSCI.CFG
file for the INN software.

TECHNICAL SUPPORT
If you experience problems installing or operating INN, or if you have any questions
concerning any of the above steps, our Technical Support team will be happy to assist you.

CONTACTING INN TECHNICAL SUPPORT -

Please call 1-800-462-4461 between 8:00 am and 10:00 pm PST, seven days a week.  You
can also reach us on INN at mailbox #950, by fax at (209) 642-0885, by TTY/TDD (for the
hearing impaired) at (209) 658-7977, or by mail at the following address:

The ImagiNation Network
P.O. BOX 1550
Oakhurst, CA 93644
ATTN: Technical Support
BEFORE YOU CALL

To help us provide the best service possible please be in front of your computer when you
call and have the following information ready: What is your member number or Mailbox
number?  Modem brand name and type (internal or external)?  What COM port is the
modem is set to?  Do you have a Serial or Bus mouse?  Are you getting an Error message?
What network access phone number did you choose for the program to call?
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